Quick Start Summary Guide

This information should be used as a brief “how to use” guide. For complete “how to use” information
please use the Instruction manual that follows this Summary.

To Program from a Master Chip:

1.
2.
3.

4.
5.

Turn the programmer on, then bring up the 869 software.

Choose the “Select” icon and select the device that you would like to program.

After you have selected the device go to the “Read” icon and read the device. The
information on the “Master” chip will be loaded into the buffer, now you are ready to
program.

Go to the “Program” icon and program you device.

After you have programmed you device go to the “Verify” icon and verify that the
information on the device is correct.

Note: If you wish to program from another “Master chip” you will have to go through steps 2-4.

To set up programmer for Stand Alone use:

1.
2.

3.
4

Field use:
1.

o

10.
11.
12.
13.

Turn the programmer on, then bring up the 869 software.

Go to Library on the tool bar, then go to modify where you can select the device that you
are looking for. Once you have found the device click on “Add” then OK and it will be
added to the list of devices for stand-alone use.

Go back to library and select transfer. This will transfer over all the device and driver
information for stand-alone use.

Turn off power and disconnect com cable from program.

Make sure that power is connected to the unit. Turn power on. Insert “Master chip”.
Under Select Function. Press down arrow until you reach “2. Select Device” . Press
Enter.

Select Manufacturer using up and down arrows. When manufacturer is found press
Enter.

Select type appears. If multiple devices have been loaded use up and down arrows to
scroll to find device. Press Enter.

Once the device has been selected the “Run” option will appear. Press Enter.

The device number will appear at the top, using the up and down arrows scroll to Read.
Press Enter.

Once the chip has been “Read” the file will be loaded into the buffer.

Remove “Master chip” and place a blank chip in to the socket. Press Exit once.

The Run option will appear on the display. Press Enter. Scroll down using up and down
arrows until you reach “Program”. Press Enter.

The chip is now programmed. Press Exit.

Scroll down using up and down arrows until you reach “3. Buffer”. Press Enter.

Scroll down using up and down arrows until you reach “2. Checksum”. Press Enter.
The Checksum will appear, if it is correct the chip has been programmed. If the value
differs from the “Master chip” erase the chip or get a new chip and repeat the previous
steps.
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1.General Description

1.1 INTRODUCTION

1.1.1 What is the 8697

The 869 is an affordable, reliable, and fast Universal Stand Alone Device Programmers. It is
designed to communicate with the parallel (printer) port and to operate with a IBM-compatible desktop
computers and notebook computers. The menu-driven software interface makes it easy to operate.

The programming hardware includes the following features:

1. A sleek, low-profile, programming module includes a 48 pin ZIF (Zero Insertion Force) socket.
2. An AC adapter.

3. A parallel connecting cable.

The software includes the following features:

1. User-friendly interface with pull-down menus, pop-up dialogue boxes, and help.

2. WINDOWS95/98, WINDOWS/NT or WINDOWS2000 compatible.

3. Integrated full screen editors with fill, copy, move, locate, swap etc.

4. Programming support for a large number of devices, including PROMs, EPROMs, PLDs, and
Microcontrollers from many manufacturers.

5. IC test capability for TTL and CMOS Logic ICs.



6. Support of Intel (linear & segmented) HEX, Motorola S, and Tektronix (linear & segmented) formats.
7. Device Insertion Test.
8. Auto-generation of electronic serial number.

1.1.2 Manual organization

The Guide consists of three main parts:

Part 1: These chapters provide an introduction to the 869. Some of the items covered are: included features,
system requirements, set-up of the hardware and software, and so forth.

Part 2: These chapters have brief explanations for each of the software functions.

Appendices: These appendices contain information on customer support.

1.1.3 Manual convention

The following conventions are used in this manual:

The names of all keyboard keys are enclosed in angle brackets, <>. For example, the Enter (or Return)
key is shown as <Enter>; the Page Up key is shown as <PgUp>.

The cursor keys are shown as follows:

Left arrow key = <Left arrow>

Right arrow key = <Right arrow>

Up arrow key = <Up arrow>

Down arrow key = <Down arrow>

Unless stated otherwise, keystrokes are not case-sensitive. e.g.: Both'A' and 'a' are acceptable.

1.1.4 Device insertion

There are three ways to insert devices into the programmer socket: normal insertion, special insertion, and
adaptor insertion.

Normal insertion: Following the reference diagram next to the socket, always insert the device into the
bottom of the socket, oriented with the pin 1 located in the upper left corner.

Special insertion: For some low end models, a few devices may need to be inserted in a non-standard way.
The instructions for insertion of the device of interest will appear on the screen when the selection of the
device is made.

Adaptor insertion: Some devices may require the use of adaptor. If this is the case, a window will be
displayed on the screen with instructions. Please check with your supplier if you need to program any
device which may require a particular adaptor. The adaptor list and price list can be provided on request.

1.2 REQUIREMENTS
1.2.1 System

The minimum requirements are as follows:

1. An IBM-PC/386/486/Pentium, or compatible clone.

2. One parallel port, such as LPT1 (278H), LPT2 (378H), or LPT3 (3BCH).

3. MS-WINDOWS9x/NT.

4. Diskette drive (3.5" 1.44 Mbyte), or CD-ROM for installation, copying, and saving of the software and
data files.

5. One hard disc drive for operation, with at least 10 Mbyte of spare capacity.

6. Color graphic adaptor and monitor. The software operates in text mode and supports all color graphic
devices.

1.2.2 Packaging

Your package should contain the following:

1. a programmer module.

2. a parallel connecting cable (1 m).

3.a 12 Volt, 3 Amp, AC Adaptor (110 V/220 Vac), a User's Guide, etc.
4. a software diskette or CD-ROM.



1.3 Getting Started

1.3.1 Installing software

Insert the installation disc into a drive (A: or B: or CD-ROM). Run the installation program SETUP.EXE.
You may select the directory of your choice to install the software, at the beginning of the installation.
Then, the installation program creates three sub-directories, normally BIN, LIB, and ALGO. The library
files will be copied into the LIB sub-directory, and the algorithm files will be copied into the ALGO sub-
directory.

1.3.2 Installing hardware

The 869’s are specially designed for the PC's printer port; no separate interface card is needed. This feature
is very handy for notebook computer users. The programmer is connected to one of the standard printer
ports, LPT1 (278H), LPT2 (378H), or LPT3 (3BCH), automatically.

Connect the programmer module to the computer's printer (parallel) port with the provided cable. Then
connect the AC adaptor to the programmer's power jack. Now, turn on your programmer.

1.3.3 Running the software
To run the 869 software, double-click: BK869.EXE ,for example
Note: Insert the chip only after the software communication check is OK.

1.3.4 Communication error

A communication error may occur if a device is locked in the programmer's ZIF socket when invoking any
of the software routines. Make sure the socket is empty when invoking any of the routines. Once the
menu is on the screen, you can lock the socket by pulling down the lever.

A communication error may also occur if the programmer is not connected to the printer port properly, or if
the power switch is not turned on. The software finds the right port when the software is installed. If you
moved the programmer to a different port, use the software menu Setting to communicate again.
Communication searches programmer itself.

1.4 Applications

1.4.1 Programming

Quick programming a device:

Select the device: From the main screen, use the mouse to click on the Device menu, then click on the
Select sub-menu. A window named “Select” pop out. First select the type of device (This option is on the
right-hand side of the window). After you have chosen the correct device type, select the correct
manufacturer and device name. (You may do this by using the mouse to scroll through the Manufacturer
or Device box). When you have finished selecting the information on the chip to program, choose OK
button in the lower right-hand corner.

The next process is to load the data that you wish to program into the buffer. You may do this by loading
a data file into the buffer, by reading data into the buffer from a master chip, or by typing the data into the
buffer directly.

Loading a file: You may load a file into the buffer by clicking on the File menu in the main screen.
Then select the Load sub-menu by clicking it with the mouse. A window allowing you to select a file to
load will then open. Select the file name you wish to load, Then a window of data format will pop out.
Select data format of the file you wish to load. This will automatically load your file data into the buffer.
Reading data from master chip: From the main menu, click on Device and a list of sub-menus
appear. Click on the Run sub-menu, a Function Dialog pop out. Double-click the Read function in the
Function box. This loads the data from the master chip to the buffer, and you can then program this data to

another chip.



Program device: Click on the Device menu from the main screen, and select the Run sub-menu.
When the Function Dialog is opened, double-click on the Program function. Your data will then be
programmed into the chip. To check if programming is correct, you must verify .

1.4.2 Testing

The programmer can test logic ICs and RAM memory devices. The menu-driven software provides an easy
interface for loading and editing test patterns to test a device. TTL.LIB contains the TTL and CMOS test
patterns. The following shows the steps to test logic ICs and RAMs:

1. Place the device of interest into the ZIF socket and lock it.

2. From the main menu screen, select Test TTL & CMOS Test.

3. Enter the device name in the box provided. If the device is not found in the TTL.LIB library, an error
message will be displayed. You can also select a device from the list viewer.

4. Clicking OK, the test result will be displayed.

You can even find the type of an unknown chip by selecting Auto find.

For testing RAM, follow the same procedure as for Programming. The only difference is that there is only
Test in the Function Dialog.

1.4.3 How to edit auto

IC has special functions that listing in Function Dialog. There is also a function Auto allowing completing
many functions at one operation. You can edit Auto using EditAuto Dialog. Left list box listing all
functions that device has. Double clicking on the name of function will add it to Auto file. The function
“Auto” will sequence operation according you select.

1.4.4 Auto Increment

This allow auto to increase in programming. If enable autoincrement, special address buffer data will auto
increment. For example, programming Intel 87C51.1f selecting format Binary, at end of buffer ,eight byte
will be used.

Fisrt programming:

Value: 00 00 00 00 00 00 00 00

Address: 0xFF8 OxXFFF

Second programming:

Value: 00 00 00 00 00 00 00 01
Address: 0xFF8 OxFFF
Format: Binary is from 00 00 00 00 00 00 00 00 to FF FF FF FF FF FF FF FF

ASCII HEX is from 00000000 to FFFFFFFF
ASCII Decimal is from 00000000 to 99999999
You can change data in buffer edit directly.

1.4.5 What is Config
Configuration file is a file that keep the message of current selected device. A default configuration file will
be loaded before running software or saved after exiting software.

1.4.6 Buffer-Keeping

Buffer data will be loaded from a file before running software or saved to a file after exiting software, Also
include Encryption data if existing.

1.4.6 How to load file

Loading file into buffer has some options: File format ,Buffer address and File Address.



For example, load file from address 0x40 and fill into Buffer beginning at address 0x20,must complete
“File type” dialog correctly.

The Result is:

2.Description of Menus

In the first part of the manual very basic information has been dealt with. In the second part the usage of
each menu will be briefly explained. For the most part the menus are self-explanatory. But this section
may help to answer any questions about a menu that is not familiar to you.

Main Menu and Edit Menu

The Main menu contains all the current data relevant to the chip specified for programming. Across the
top of the main screen is the menu bar, which consists of the menus: File , Buffer, Device, Test, Option,
View, Window, and Help.

The Edit menu consists of the menus for editing buffer data, close buffer editing window to return

Main menu. Some functions only valid in Software for Windows Version

2.1 File: <Alt-F>

This menu deals with data file management and system interfacing.

2.1.1 Load: <Ctrl+O>

Files loaded into the programmer are divided into two types. For programming memory and
Microcontroller chips, data file types are generally HEX or Binary. For programming PAL or PLD chips,
the data file type is .JED (JEDEC).

Loading files for Memory or Microcontroller chips

Data types supported are Binary (also .POF), Intel HEX (also extended HEX), Motorola S record, and
Tektronix HEX types. Select the appropriate type for your data file. For Binary type data, it is possible to
set buffer offset and file offset addresses.

To select a data file to be loaded, the path and the file name should be entered into the name field. If the
full path or the exact name of the file is not known, then a partial path may be entered using wild cards, e.g.
“** or “* BIN.

Loading JEDEC (JED) files

If the selected device type is PLD, the Load JED File dialogue box will pop up. Type in the file name and
press return.

(You can choose PLD in the sub-menu Manufacturer’Default device format.)

2.1.2 Save

This selection will save the current data from the buffer into a file whose name is supplied by you.

For PLD devices, the Save JED file dialogue box will pop-up. It consists of Name (input line), Files (list
viewer), OK and Cancel buttons. You can indicate the directory and the name of the file to be saved in the
input line, labeled Name.

For E(E)PROM, BPROM or MCU device types, the box named Save File will be displayed. This
dialogue box consists of an input line titled Name, a list viewer titled Files, an input line for Buffer offset,
another input line for Save size, radio buttons for File format, and the OK and Cancel Buttons. You must
input the path and the file name in the Name input line. The format of the file to be saved must also be
selected in the File format area by pressing one of the radio buttons.

2.1.3 Exit



This command closes the programmer software and returns you to the control of the operating system.

2.Buffer: <Alt-B>
This menu manages the data file.

2.2.1 Edit

This selection brings up the Fuse Buffer edit window if the device type is a PLD, or the Data Buffer edit
window for memory devices. The buffer is for 8-bit data, and the numbers in the left column are the
addresses of the buffer. You can edit the buffer data on the screen with the following keys:

<PageUp> :Page up

<PageDown>  :Page down

<Ctrl-PageUp> :Move cursor to the beginning of the buffer

<Ctrl-PageDown>:Move cursor to the end of the buffer

<Home>:Move cursor to the beginning of the line

<End> :Move cursor to the end of the line

For the Fuse Buffer edit window, 1 is logic High and 0 is logic Low.

The Data Buffer edit window has two edit areas: one supports Hex code, and the other supports ASCII.
You can switch the cursor between the two sections with <Tab>.

Locate

This selection is convenient for locating a set of data for editing. This selection will bring up the Locate
buffer dialogue box, which consists of the New address input line, OK and Cancel buttons. Key into the
input line the address you wish to be displayed on the current screen, and press OK. The cursor will blink
at the address specified in the space marked New address.

Fill

This selection will bring up the Fill buffer dialogue box. It consists of the Start address input line, End
address input line, Fill data input line, OK and Cancel buttons. Input any desired data to be filled into the
Fill data input line, and specify the range by indicating the beginning and ending addresses. For the Fuse
buffer edit window, the data will be either 1 or 0. For the Data buffer edit window, it will be a two
character HEX code.

Copy
This selection displays the Copy buffer dialogue box. It consists of the Start address input line, End address

input line, New address input line, OK and Cancel buttons. Data between Start address and End address will
be copied to the buffer starting from New address.
Note that the source and destination areas must not overlap.

Swap

Swap byte order with specific word width and address range.
Radix

Toggles HEX/DEC memory address display.

Search

Search for a combination of hex/ASCII codes (search string).

Next

Performs the next search for the search string in 'Search’.

2.2.2 Encryption Table

The Load Encryption Table, with its two sub-menus, manages an encryption array. The two sub-menus
will appear only if the chip of interest is equipped with an encryption array, and the right selections have
been made for the manufacturer and the part number of the chip.

Load: Brings up the Load Encryption Table dialogue box. It consists of the Name input line, File list viewer,
OK and Cancel buttons. This selection loads an encryption table.

Edit: Opens the Encryption Buffer edit window for viewing and editing.

2.2.3 Vector Table

This opens the Vector Buffer edit window. If a test vector table is included in a JEDEC file, the software
will load the test vector table to the buffer automatically when the JEDEC file is loaded. Refer to the



following when editing the test vector.

High impedance state

Don't care state

Vce and ground (output pins are not tested)
Output logic High (Voh)

Output logic low (Vol)

Clock pin

Input logic High (Vih)

Input logic Low (Vil)

STODITZXN

2.3 Device: <Alt-D>

This menu is used to choose Function Select, the IC manufacturer, the device type, the device name of the
chip to be programmed, and to specify the Word Format.

To select a device, first click on the Select box. This allows the selection of the manufacturer followed by
the device part number. (Make sure that you always select the Type of device you are going to program,
before selecting either the manufacturer or the part number.)

If you are ready to operate on a device (e.g. program or read), then click on the Function Run sub-menu.
2.3.1 Run

This selection is used to perform programming and reading on a device.

This selection brings up the Function dialogue box and displays information on the selected device. It
consists of the following: Function select list viewer, Message (and the blue information display windows
on the bottom), Chip start, Chip end, Buff start, Buff end input lines, OK and Cancel buttons.

The Function select list in the Function dialogue box is crucial to programming, and will be explained
according to the Device Manual from the manufacturer.

Program

This 'burns' the data from the buffer into the chip. The Verify function is performed automatically after
programming is complete. If an error occurs, the error message will be displayed along with the addresses
and data of the chip and buffer where the error started. Any other result will be displayed in the Message
section. The current address is incremented in the Current Address display window while the chip is being
programmed or verified. In the case of ROM, the range for the buffer and chip addresses, to be used for
various functions, can be changed in the right half of the Address box.

Read

This reads the content of a chip into the buffer. After reading is complete, the checksum of the data will
be displayed in the cobalt blue background screen (in the lower-left corner). If the chip selected is either a
PAL of GAL, the blow count will be shown instead of the checksum. When a GAL is programmed, the
device should be specified correctly (otherwise an error message will be displayed and the chip will not be
programmed or read). If the security fuses are blown in a PAL of GAL, the data read from the chip will be
all 1's or 0's instead of the real data, due to the data protection scheme.

If it is a ROM or Microcontroller, the data between the chips start address and the end address will be read
into the buffer. The range of the addresses in downloading transactions, and the result of the transactions,
will be displayed in the Message display window.

Verify

This function compares the contents of the buffer and the contents of the chip. If the data in the buffer is
different from the data in the chip, the Verify Failure message and the address where it started failing will
be displayed in the Message window. For a ROM or Microcontroller, verification of a range between a
start and end address (specified by you) is possible.

Blank Check

This function checks that a memory device is correctly erased. For a ROM or Microcontroller, checking
of a range between a start and end address (specified by you) is possible.

Data compare

This function is for a ROM or a Microcontroller. It will generate a file which contains all the differences
between the chip and the buffer. The name of the file will be the name of the device selected with .CMP
suffixed. For example, if the device is AMD 27256, then the file name will be 27256.CMP. (This file is
stored in the \BIN directory.)



Auto
This function will execute several functions in a sequence. Generally, it executes Blank check, Program,
and Verify. For a GAL it executes the Erase function at the beginning and sets the Security bits at the end.
Security
This feature applies to PLDs and Microcontrollers equipped with a security function. If the security is set,
the data programmed into a chip will not be read correctly.
Note: Lock, Protect, etc.. also mean Security dependent on Device.
Encryption
This applies only to some Microcontrollers. This will program the content of the encryption table onto the
encryption array of a chip. The content of the encryption table can be loaded, saved, and edited. Once
encryption is completed, the data in the main buffer will be the Exclusive-NORed data with the encryption
table.
Message
The message area displays error messages which occur during programming, and the result of executing a
function.
Environment
It displays the selected manufacturer (MFG), the device name (Device), the checksum (Checksum) for HEX
files, and the blow count (Blow Count) for JED files, etc.
Chip start
Input an address for the chip where you would like a selected function of downloading or uploading to start.
Chip end
Input an address for the chip where you would like a selected function of downloading or uploading to end.
Buff start
The address in the buffer where file loading begins. By changing the address, a file can be loaded at any
desired location.
Buff end
The address in the buffer where file loading ends. By changing the address, a file can end loading at any
desired location.
Note: Chip start, Chip end, Buff start, and Buff end, are used in multiple loading and offset programming.
Multiple loading means that a buffer can be filled with different sections of data from a chip or file. Offset
programming means that a chip can be programmed with different segments of the data in the buffer.
2.3.2 EditAuto
This menu Edit auto sequence for automatic operations on device.
2.3.3 Select
This selection brings up the Select Devices dialogue box. It consists of Manufacturer list viewer, Device
list viewer, Type radio button, a OK , Cancel buttons and Search Edit Box.
In this window, when the green highlighted cursor is placed over a name of the manufacturer, the names of
the devices for the manufacturer selected will be listed instantly in the Device column.
The Type radio button allows you to select one of the different device types, such as, E'EPROM, B/PROM,
PLD, MPU/MCU. Select the device type before selecting any manufacturer of a device.
The Search Edit Box allows you to search Device quickly. You can enter device name with a few keychars,
then this window will list all possible devices.
2.3.4 Word Format
The Word Format window allows you to specify the data format loaded into the buffer. The default
setting is Gangl-byte. Changing the setting is necessary only if the data loaded is not in normal byte (8-
bit) mode; then it will be necessary to select a specified byte for programming purposes.
The Word Format selection brings up the Word Format dialogue box, which consists of the Word Format
radio buttons, OK and Cancel buttons. The details of formatting are as follows.
Byte
This processes in a normal 8-bit data format.
Even Word
This processes in a 16-bit data format. When Even Word is indicated, the unit will program only the data
bytes at the even addresses to an 8-bit wide device. For example:

Given:
buffer address 00 01 02 03 04 05 06 07



buffer data 01 23 45 67 8 AB CD =
Result after programming:

device address 00 01 02 03
device data 01 45 8 CD -
Odd Word

When Odd Word is indicated, the unit will program the data bytes at the odd addresses to an 8-bit wide
device. For example:

Given:
buffer address 00 01 02 03 04 05 06 07
buffer data 01 23 45 67 8 AB CD EF
Result after programming:
device address 00 01 02 03
device data 23 67 AB EF -

Note: The next four topics are for the word format for double words (32-bits) as a unit of processing data.
There are four kinds of formats in Double word. The following example will be used for explaining the
four formats of Double word.

Given:
buffer address 00 01 02 03 04 05 06 07 08 09 OA OB
buffer data 01 23 45 67 89 AB CD EF FE DC BA 98

Double Word 0

This will process the data at addresses 00, 04, 08 for reading, verifying, and programming. (e.g: 01
89 FE)

Double Word 1

This will process the data at addresses 01, 05, 09_ for reading, verifying, and programming. (e.g: 23
AB DC)

Double Word 2

This will process the data at addresses 02, 06, 0A_ for reading, verifying, and programming. (e.g: 45
CD BA)

Double Word 3

This will process the data at addresses 03, 07, 0B_ for reading, verifying, and programming. (e.g: 67
EF 98)

2.4.Test: <Alt-T>

The 869’ s can test logic ICs and RAM devices, as well as perform vector testing on PLDs.  The user-
friendly software provides an easy interface for loading files, editing test patterns, and downloading and
uploading data between the buffer and the device. The 869’ s provide a 74/54 and 4000/45000
TTL/CMOS logic device test library, and memory test algorithms. The following sections describe the
functions available for testing logic ICs and RAMs.

Tests are performed by applying the input(s) specified in the test pattern (see below) and checking for the
specified output(s). Up to 291 I/O combinations can be specified in a test pattern, allowing quite complex
devices to be tested.

2.4.1 New Pattern

To test a new device that is not included in TTL.LIB, a new test pattern may be created.

To access this function, click on the Test menu from the main screen, and then click on New Pattern. This
selection brings up the Append dialogue box, which consists of IC Type input line, Pin number input line,
and the OK and Cancel buttons. You can input the new IC name and number of pins in the input lines. If
the name and the number of pins are not in the current library, pressing OK will open the XXXX edit
window (XXXX is the new device name that was entered). Refer to the following when editing a pattern.
The following symbols are used throughout the sub-menus of Test:

: Vce pin

GND (Ground) pin

Unused or power pin; output values will not be tested

Output Logic High (Voh)

Output Logic Low (Vol)



C: Clock pin

1: Input Logic High (Vih)

0: Input Logic Low (Vil)

2.4.2 Edit Pattern

This selection is used for editing a test pattern in the library. When you are in the Test menu, click on Edit
Pattern. This brings up the Select Chip to Edit dialogue box. It consists of Select Type input line, a device
list viewer, and the OK and Cancel buttons. You can enter the device name into the input line, or select
from the list viewer. On accepting the device name, the software opens the edit window with the name of
the device at the top. You may now use the above information to edit your pattern.

2.4.3 Delete Pattern

This selection deletes a test pattern in the library.  Click on the Delete Pattern sub-menu in the Test menu.
This will bring up the Select Chip to Delete dialogue box. Highlight the test pattern you wish to delete and
click on the OK button. The test pattern will be deleted and you will return to the main menu. Make sure
you have made the correct selection. The only way to retrieve a deleted test pattern is to recreate the
pattern (using 'New Pattern').

2.4.4 TTL&CMOS test

This selection tests TTL and CMOS devices. Click on the sub-menu TTL & CMOS test in the Test menu.
This will open the Select Chip to Test dialogue box. Highlight the device that you wish to test, and then
click on the OK button. ~ The result of the test will be displayed in the window Test TTL, which will
appear after clicking the OK button in the Select Chip to Test dialogue box. If the device passes the test, a
'passed' test message will be displayed. If the test fails, information about where it failed is displayed. If
you want to repeat the test, click on the Repeat button. Otherwise click on the Cancel button.

2.4.5 Auto find device

This selection finds out the name of an unknown device. Click on the sub-menu Auto find device. This
will initiate a search for the device type inserted in the programmer. The device name found will be listed
in the list viewer, List of Detected Chips, if the device can be listed. If the device cannot be found, it will
display an error message, No chip found. To make sure the chip is programmable, manually enter the
manufacturer and the device name in the given boxes, under the Device menu.

2.4.6 Vector test

To perform vector testing of a device inserted into the programmer, click on the Vector Test sub-menu in
the Test menu. This will initiate the test procedure and open up the Test vector window. Here, the result
of the testing will be displayed. If you wish to repeat the test, click on the OK button. This will initiate the
test procedure again. If you want to return to the main screen, click on the Cancel button.

2.5 Option: <Alt-O>

This menu deals with optional settings, such as changing the port address, and specifying paths for the
software. In short, all the optional menu settings and configurations for running the program can be set
here.

2.5.1 Setting

This menu deals with optional settings, such as communication, and specifying paths for the software. In
short, all the optional menu settings and configurations for running the program can be set here.

This selection brings up the Setting dialogue box, which consists of the Directory, CPU Speed, and other
options depending on programmer. Gray means that the programmer doesn’t support.

Directory: You can specify where the files and libraries are located. This is required following the
installation process, to allow correct operation of the software.

CPU Speed: On some (particularly older) PCs, the parallel port is unable to keep up with the data rate
normally used to communicate with the programmer hardware. In this case you should set the speed to
Low in CPU Speed.

Option: Check “Insertion Test” if you want the programmer to do an insertion test before any operation on
the device. Check “Beeper” if you want the programmer to beep after any operation .

Initialize Programmer: Clicking on communication will search the programmer through all possible parallel
port. If find the programmer, the communication will be successful. If not, a window named Error will
appear .

Data Buffer: If checking, buffer will be clear before changing IC or loading data from file.



2.5.2 Auto Increment

This selection brings up the auto increment set dialogue box. You can set auto start and auto end address
in the buffer, you can also set increment value with <10 data. The increment format allows increment at
method as:Binary, ASCII HEX and ASCII Decimal.

If you want change the current increment data, enter the data edit window, you can change data directly.
2.5.3 Load config file

This selection brings up the Load config File dialogue box. You can select and load a previously saved
configuration file, which has all the information about the manufacturer, chip type, part name, port address,
and other setups.

2.5.4 Save config file

This selection brings up the Save config File dialogue box. You can select, or input, a configuration file
name to save all the current settings into that file. This box looks the same as the Load config File
dialogue box shown above, but instead of seeing a Load button, you will see a Save button.

2.6 View: <Alt-V>

2.6.1 ToolBar

To show or hide the toolbar. On the View menu, click Toolbar. When the command has a check mark next
to it, the toolbar is on.

2.6.2 StatusBar

To show or hide the status bar. On the View menu, click Status Bar. When the command has a check mark
next to it, the status bar is on.

2.7 Window: <Alt-W>

2.7.1 New Windowsm_newwindows

To open another

2.7.2 Cascadem_Cascade

This command stacks all open edit windows and overlaps them so that each is the same size as all others
and only part of each underlying window is visible.

2.7.3 Tilem_tile

This option arranges the windows so they cover the entire desktop without overlapping one another.
2.7.4 Aarrange Iconsm_icons

The Arrange Icons command rearranges any icons on the desktop.

Rearranged icons are evenly spaced, beginning at the lower left corner of the desktop.

2.7.5 InfoViewm_infoview

To open an Information Window. It contains the information on the manufacturer of the device selected for
programming, and the location of the BIN, LIB, and ALGO directories in your system.

3.Appendices

3.1 Warranty and Service Information

Limited One-Year Warranty

B&K Precision Corp. warrants to the original purchaser that its product and the component parts thereof,
will be free from defects in workmanship and materials for a period of one year from the data of purchase.

B&K Precision Corp. will, without charge, repair or replace, at its’ option, defective product or component
parts. Returned product must be accompanied by proof of the purchase date in the form a sales receipt.

To obtain warranty coverage in the U.S.A., this product must be registered by completing and mailing the
enclosed warranty card to B&K Precision Corp., 22820 Savi Ranch Parkway, Yorba Linda, CA 92887



within fifteen (15) days from proof of purchase.

Exclusions: This warranty does not apply in the event of misuse or abuse of the product or as a
result of unauthorized alternations or repairs. It is void if the serial number is alternated, defaced
or removed.

B&K Precision Corp. shall not be liable for any consequential damages, including without limitation
damages resulting from loss of use. Some states do not allow limitation of incidental or consequential

damages, so the above limitation or exclusion may not apply to you.

This warranty gives you specific rights and you may have other rights, which vary from state-to-state.

Model Number: Date Purchased:

Service Information

Warranty Service: Please return the product in the original packaging with proof of purchase to the below
address. Clearly state in writing the performance problem and return any leads, connectors and
accessories that you are using with the device.

Non-Warranty Service: Return the product in the original packaging to the below address. Clearly state
in writing the performance problem and return any leads, connectors and accessories that you are using with
the device. Customers not on open account must include payment in the form of a money order or credit
card. For the most current repair charges contact the factory before shipping the product.

Return all merchandise to B&K Precision Corp. with pre-paid shipping. ~ The flat-rate repair charge
includes return shipping to locations in North America. For overnight shipments and non-North America
shipping fees contact B&K Precision Corp.

B&K Precision Corp.
22820 Savi Ranch Parkway
Yorba Linda, CA 92887

Email: service@bkprecision.com

Include with the instrument your complete return shipping address, contact name, phone number and
description of problem.

3.2 ERROR MESSAGES

3.2.1 InValid File Type:An input file with wrong format is selected. Please select right format for the
input file.

3.2.2 Init Programmer error(Programmer init error): Communication searches no programmer
connected. Software only works in Demo method. Be sure programmer powering on, search programmer
with communication(See Setting sub menu) again.

3.2.3 Algorithm file not found: Every device has an algorithm file. After selecting the device, running
will load algorithm file(DLL file).If loading failed, show this message, and algorithm file name with full
path.
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